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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Select Multiple Objects Using the Shift Key.
	8-1
	Click an object on the slide. Hold down [Shift] and click another object.
	Market2.ppt
	None

	Select Multiple Objects by Drawing a Selection Rectangle.
	8-2
	Position the pointer in a blank area on the slide. Left-click the mouse, hold down the left mouse button and drag the crosshair diagonally to the right and up to draw a dotted box—selection rectangle—surrounding all the objects that have to be selected.
	None
	None

	Remove an Item from a Group of Selected Objects.
	8-3
	Hold [Shift] and click an object that has to be deselected from the group of selected objects.
	None
	Sol 8-3.ppt

	Align Objects Horizontally and Vertically.
	8-4
	Select the objects. Click Draw on the Drawing toolbar, point to Align or Distribute, and choose the appropriate alignment option.
	None
	None

	Distribute Objects Horizontally and Vertically.
	8-5
	Deselect the objects and reposition them. Reselect the objects and click the Distribute Vertically button from the Align and Distribute toolbar. With the objects still selected, click the Distribute Horizontally button.
	None
	None

	Align Objects Relative to the Slide.
	8-6
	Select the objects. Click the Relative to Slide button on the Align and Distribute toolbar. Click the appropriate alignment option.
	None
	None

	Flip and Rotate Objects.
	8-7
	Select an object or group of objects. Click Draw on the Drawing toolbar and point to Rotate or Flip. Drag the submenu’s title bar to float the toolbar. Click the Flip Horizontal or Flip Vertical button. Click the Rotate Right or Rotate Left button.
	None
	None

	Change Forward/Backward Stacking Order.
	8-8
	Select an object. Click Draw on the Drawing toolbar, point to Order, and then choose Bring Forward.

Select an object. Click Draw on the Drawing toolbar, point to Order, and then choose Send Backward.
	None
	None

	Bring to Front or Send to Back.
	8-9
	Select an object. Click Draw on the Drawing toolbar, point to Order, and then choose Bring to Front. 

Select an object. Click Draw on the Drawing toolbar, point to Order, and then choose Send to Back.
	None
	Sol 8-9.ppt

	Group Objects.
	8-10
	Select the objects that have to be grouped. Click Draw on the Drawing toolbar and then click Group.
	None
	None

	Ungroup and Regroup Objects.
	8-11
	Select the grouped objects. Right-click the group and select Grouping and then Ungroup. 

Select any one of the objects that were previously grouped. Click Draw on the Drawing toolbar and choose Regroup.
	None
	Sol 8-11.ppt

	Format Part of a Grouped Object.
	8-12
	Select the objects on a slide and group them. Click the edge of an object from the group to select it. Apply the desired formatting.
	None
	None

	Apply a Shadow Effect.
	8-13
	Select an object. Click the Shadow Style button on the Drawing toolbar. Choose a style.
	None
	None

	Customize a Shadow.
	8-14
	Select an object. Click the Shadow Style button and choose Shadow Settings. Choose the desired shadow setting option.
	None
	None

	Choose a 3-D Effect.
	8-15
	Select an object. Click the 3-D Style button on the Drawing toolbar. Choose the desired effect.
	None
	None

	Customize a 3-D Effect.
	8-16
	Select an object. Click the 3-D Style button and choose 3-D Settings. Choose the desired 3-D setting option.
	None
	Sol 8-16.ppt

	Duplicate an Object.
	8-17
	Select an object. Choose Edit, Duplicate; or press [Ctrl]+[D].
	None
	Sol 8-17.ppt

	Duplicate a Slide.
	8-18
	Select a slide. Choose Edit, Duplicate; or press [Ctrl]+[D].
	None
	None

	Ungroup and Change Fill Color for Parts of an Image.
	8-19
	Select a vector-based clip art picture. Click Draw on the Drawing toolbar and choose Ungroup. Click Yes in the Confirmation box to convert the picture to a Microsoft Office drawing object. Click Draw and choose Ungroup again. Press [Esc]. Click any of the clip art pieces and fill it with a different color. Select all the clip art pieces. Click Draw and then choose Group.
	None
	None

	Delete Parts of an Image.
	8-20
	Select a vector-based clip art picture. Click Draw on the Drawing toolbar and choose Ungroup. Click Yes in the Confirmation box to convert the picture to a Microsoft Office drawing object. Click Draw and choose Ungroup again. Press [Esc]. Click any of the clip art pieces and press [Delete]. 
	None
	Sol 8-20.ppt

	Optimize Photograph Images.
	8-21
	Select a picture. Click the Compress Pictures button on the Picture Toolbar. Choose Apply to and Change resolution options in the Compress Pictures dialog box. Place check marks on the Compress pictures and Delete cropped areas of pictures options as desired.
	None
	Sol 8-21.ppt

	Select multiple objects; and align, distribute, flip, rotate, and group objects.
	8-22
	
	Cooking3.ppt
	Sol 8-22.ppt

	Align and distribute objects relative to the slide and to each other and work with layers of objects.
	8-23
	
	MiamiBch2.ppt
	Sol 8-23.ppt

	Align, distribute, and group objects; work with layers; apply shadow and 3-D effects; and duplicate objects.
	8-24
	
	Admedia3.ppt
	Sol 8-24.ppt

	Work with layers of objects, align and distribute objects, flip an object, group objects, and use advanced image editing tools.
	8-25
	
	Openings3.ppt
	Sol 8-25.ppt

	Select, align, and layer multiple objects; group and ungroup objects; and work with object shadows.
	8-26
	
	InfoPak1.ppt
	Sol 8-26.ppt

	Align, distribute, and group objects; work with shadows and 3-D effects; and use the Duplicate command.
	8-27
	
	Recruit2.ppt
	Sol 8-27.ppt

	Align and distribute objects, work with layers, group and ungroup objects, and use advanced image editing tools.
	8-28
	
	Cooking4.ppt
	Sol 8-28.ppt

	Align, rotate, and flip objects, work with layers, apply 3-D effects, and use advanced image editing tools.
	8-29
	
	WhoWeAre.ppt
	Sol 8-29.ppt

	
	8-30
	
	None
	None

	
	8-31
	
	None
	None

	
	8-32
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 8.1

Working with Multiple Objects
This section focuses on:

· Selecting Multiple Objects Using the Shift Key

· Selecting Multiple Objects by Drawing a Selection Rectangle

· Removing an Item from a Group of Selected Objects
Section 8.2

Aligning, Distributing, and Flipping AutoShapes
This section focuses on:

· Aligning Objects Horizontally and Vertically

· Distributing Objects Horizontally and Vertically

· Aligning Objects Relative to the Slide

· Flipping and Rotating Objects
Section 8.3

Working with Layers of Objects
This section focuses on:

· Changing Forward/Backward Stacking Order

· Bringing to Front or Sending to Back
Section 8.4

Grouping, Ungrouping, and Regrouping Objects
This section focuses on:

· Grouping Objects

· Ungrouping and Regrouping Objects

· Formatting Part of a Grouped Object
Section 8.5

Applying Object Shadows and 3-D Effects
This section focuses on:

· Applying a Shadow Effect

· Customizing a Shadow

· Choosing a 3-D Effect

· Customizing a 3-D Effect
Section 8.6
Using the Duplicate Command
This section focuses on:

· Duplicating an Object

· Duplicating a Slide
Section 8.7
Using Advanced Image Editing Techniques
This section focuses on:

· Ungrouping and Changing Fill Color for Parts of an Image

· Deleting Parts of an Image

· Optimizing Photograph Images
	Lecture Outline
	Lecture Notes

	Section 8.1

Working with Multiple Objects
In PowerPoint, users can format several objects on a slide by using multiple selection techniques. The two basic ways to select multiple objects on a slide are:

· Select one object, hold down [Shift], and click another object.

· Draw a selection rectangle by dragging the mouse around the objects that need to be selected. 
All objects on a slide can be selected at once by choosing the Select All command from the Edit menu or by pressing [Ctrl]+[A]. 
To deselect all items, users need to click a blank area of the slide or press [Esc].
Selecting Multiple Objects Using the Shift Key
To select multiple objects one at a time, users must click one object, hold down [Shift], and click another object. On selection, sizing handles appear around the objects.
Selecting Multiple Objects by Drawing a Selection Rectangle
To draw a selection rectangle, users need to click anywhere in the slide and drag the mouse pointer diagonally to create a dotted box surrounding the objects that need to be selected. Only objects completely enclosed in the selection rectangle are selected. This method is convenient when selecting objects that are placed close to each other.
If users miss an object when drawing a selection rectangle, they can try drawing the selection rectangle again or add a missed object to the selection by using the [Shift]+click method.

Removing an Item from a Group of Selected Objects
Users can change the composition of a group of selected items. To do this, they need to deselect all the objects by clicking a blank part of the slide. Alternatively, they can hold down [Shift] and click the selected item to deselect it, leaving the remaining items in the group selected.

	Lesson Key Objective

Explains how to move or change a group of objects, layer objects, and align objects in order to create presentations that are more effective.

[image: image1.emf]Select Multiple  Objects Using the Shift Key


Text Figure: F8-01

Teaching Tip:

Have students practice drawing selection rectangles. Explain that it is okay to extend the rectangle past the edge of a slide, but it must start on a blank area of the slide. Remind them that only objects that are completely enclosed in the rectangle will be selected.
Text Figure: F8-02


[image: image2.emf]Remove an Item  from a Group of Selected Objects



	Section 8.2

Aligning, Distributing, and Flipping AutoShapes

PowerPoint has several tools that can be used to reorient objects on a slide. Selected objects can be rotated and flipped. They can be aligned with each other, either vertically or horizontally. Users can also distribute multiple objects by spacing them evenly across the slide either horizontally or vertically.
Aligning Objects Horizontally and Vertically
Users can distribute objects evenly on a slide using the align and distribution options in PowerPoint. These options are available in the submenu that opens on clicking Draw on the Drawing toolbar and pointing to Align or Distribute. Users can float this submenu by clicking the gray title bar on the submenu and dragging it to a convenient place on the screen.
Listed below are the buttons, with their functions, available in the Align or Distribute floating toolbar:
· Align Left – Vertically aligns the left edges of objects.

· Align Center – Vertically aligns the center points of objects.

· Align Right – Vertically aligns the right edges of objects.

· Align Top – Horizontally aligns the top edges of objects.

· Align Middle – Horizontally aligns the center points of objects.

· Align Bottom – Horizontally aligns the bottom edges of objects.

· Distribute Horizontally – Spaces objects evenly in a horizontal direction.

· Distribute Vertically – Spaces objects evenly in a vertical direction.

· Relative to Slide – It is a toggle button. When selected, it aligns or spaces objects relative to the slide. When not selected, it aligns or spaces objects relative to each other.

Distributing Objects Horizontally and Vertically
To distribute objects horizontally and vertically:
· Deselect the objects and reposition them.
· Reselect the objects and click the Distribute Vertically button.
· With the objects still selected, click the Distribute Horizontally button.

Aligning Objects Relative to the Slide
Clicking the Relative to Slide button makes it easy to center an object horizontally or vertically on a slide. When this button is selected, it aligns or spaces objects relative to the slide. When this button is not selected, it aligns or spaces objects relative to each other. 

When the Relative to Slide option is selected, a thin black outline appears around it. Users can also use this option to distribute objects evenly across a slide from edge to edge.
Flipping and Rotating Objects
The Rotate and Flip commands can be used on a single object or a group of objects. Users can rotate and flip any PowerPoint objects, including text placeholders.
	
[image: image3.emf]Align Ojects  Horizontally and Vertically


Additional Notes:

If the Drawing toolbar is not visible, open the View menu and choose Toolbars, Drawing.
Teaching Tip:

Discuss the alignment options listed in Table 8-1. 
Additional Notes:
When working with the Align or Distribute commands, be sure to pay attention to the Relative to Slide button. If this button is selected, all alignment actions will be relative to the slide, not the selected objects.

Teaching Tip:
Have students display the rulers, as it will help them position objects. Point out the dotted line on each ruler that indicates the position of the mouse pointer.


[image: image4.emf]Distribute Objects  Horizontally and Vertically



[image: image5.emf]Flip and Rotate  Objects


Text Figure: F8-03

Teaching Tip:
Point out the difference in distributing objects when Relative to Slide is in effect.

Text Figure: F8-04


	Section 8.3

Working with Layers of Objects
Objects get automatically stacked in individual layers as they are added on a slide. The most recently drawn object is added to the top of the stack. Within a stack of objects, users can move an individual object backward and forward by using the buttons on the Order toolbar. Listed below are the buttons, with their functions, available in the Order toolbar:
· Bring to Front – Brings an object to the top of the stack.
· Send to Back – Moves an object to the bottom of the stack.
· Bring Forward – Brings an object up one layer in the stack.
· Send Backward – Moves an object down one layer in the stack.
Changing Forward/Backward Stacking Order
Using the Bring to Front or Send to Back options moves a selected object to the front of all other objects or behind all other objects. Using the Bring Forward or Send Backward options moves the object one layer at a time.
Users can navigate between objects placed in a stack by pressing the [Tab] key.

Bringing to Front or Send to Back
To manipulate an object that is located behind several other objects, users can send the top objects to the back, one at a time, until the desired object is on top.

	
[image: image6.emf]Change Forward/ Backward Stacking Order

 
[image: image7.emf]Bring to Front or  Send to Back


Text Figure: F8-05
Teaching Tip:
Have students draw several shapes on a blank slide, each a different color, arrange them on top of each other, and then use the Order buttons to change their positions in the stack. Students can also experiment with using [Tab] for finding a hidden object and bringing it to the top.



	Section 8.4

Grouping, Ungrouping, and Regrouping Objects

When the objects on a slide are grouped, they are combined to act as a unit. When one object in the group is moved, all the other objects move with it. Grouping assures that the objects which are to remain grouped together are not accidentally moved individually or deleted. When users apply formatting to a group, all the objects in that group receive the same formatting.

Grouping Objects
To group objects:
· Select the objects that have to be grouped.

· Click Draw on the Drawing toolbar, and then click Group.

Ungrouping and Regrouping Objects
If an object from a group has to be deleted, resized, or repositioned, users must first ungroup the objects. When the objects are ungrouped, they once again become individual objects. After working on individual members of an ungrouped object, users can easily regroup the objects by selecting any one of the group’s original objects. The Regroup command finds all the objects of the original group that remain on the slide and groups them again.
Formatting Part of a Grouped Object
Users can easily select one object from a group to make individual changes. To do so, they need to first select the group and then click an object within the group. When selected, the object displays gray selection handles.
	
[image: image8.emf]Group Objects


Text Figure: F8-06
Teaching Tip:
Remind students that they can close a floating toolbar by clicking the Close box in the upper-right corner of the toolbar.

[image: image9.emf]Format Part of a  Grouped Object


Text Figure: F8-07



	Section 8.5

Applying Object Shadows and 3-D Effects

Users can add interest and depth to an object by applying shadows or 3-D effects. Each of these effects has its own toolbar with buttons that enable them to change the color, depth, and other attributes.

Applying a Shadow Effect
To apply a shadow to an object, users must select the object, click the Shadow Style button on the Drawing toolbar, and choose a style from the drop-down menu.

Customizing a Shadow
Users can customize an object’s shadow by displaying the Shadow Settings toolbar and using its buttons. To display the Shadow Settings toolbar, they need to click the Shadow Style button on the Drawing toolbar and choose Shadow Settings from the drop-down menu.

Choosing a 3-D Effect
To apply a 3-D effect to an object, users must select the object, click the 3-D Style button on the Drawing toolbar, and choose a style from the drop-down menu.

Customizing a 3-D Effect
User can customize a 3-D effect by using the buttons on the 3-D Settings toolbar. To display the toolbar, they need to click the 3-D Style button on the Drawing toolbar and select 3-D Settings from the drop-down menu.

The 3-D Settings toolbar can be used to change the color, angle of rotation, depth, and other features of the 3-D effect.

	
[image: image10.emf]Apply a Shadow  Effect


Teaching Tip:
Tell students to not confuse the Shadow Style button with the Shadow button on the Formatting toolbar, which is used to apply a text shadow only.
Text Figure: F8-08
Teaching Tip:
Inform students that they can control the degree of transparency for shadows. To do this, they need to click the arrow next to the Shadow Color button, choose More Shadow Colors, and use the Transparency slider in the Colors dialog box.

Text Figure: F8-09

[image: image11.emf]Choose a 3-D Effect


Teaching Tip:
Point out to students that the shadow and 3-D effects can appear similar in some instances. Also point out that an object cannot have both an object shadow and a 3-D effect at the same time.

Text Figure: F8-10

Teaching Tip:
Have students experiment with the buttons on the 3-D Settings toolbar. Remind them to use Undo to reverse their actions after they try each effect. Some 3-D settings change the default shadow color. Shadow colors can be changed using the Shadow Settings toolbar.

Text Figure: F8-11

Teaching Tip:
Inform students that “infinity” is not available if Perspective is not selected.

Text Figure: F8-12


	Section 8.6
Using the Duplicate Command
The Duplicate command is used for making additional copies of an object on the same slide. This command is similar to Copy and Paste, but the copy is not placed on the clipboard.
Duplicated objects can overlap one another or be spaced apart from each other. After users position the first duplicated object, additional duplicates are positioned with the same spacing. So careful positioning of the first duplicate is important for efficiency.
Duplicating an Object
To duplicate an object, users select the object, open the Edit menu, and choose Duplicate or press [Ctrl]+[D]. 
Duplicating a Slide

The Duplicate Slide command inserts a copy of the current slide after the current slide. When building presentations, it is often helpful to duplicate a slide as a starting point for the next slide, especially if there are a few very similar slides, or if the opening and closing slides have to be the same. Users can duplicate slides in the Slide Sorter or the Outline and Slides Pane.


	Teaching Tip:
Tell students that it is recommended to use the arrow keys to move an object instead of dragging it. This avoids the possibility of deselecting the duplicated object.
Additional Notes:

The Duplicate command works only if the duplicate copy remains selected. As soon as it is deselected, the command is no longer in effect. 
Text Figure: F8-13
Text Figure: F8-14

[image: image12.emf]Duplicate a Slide



	Section 8.7
Using Advanced Image Editing Techniques

PowerPoint enables users to perform additional editing on pictures that are vector-based drawings (for example, Windows Metafile drawings with the file extension .wmf). These pictures can be converted (ungrouped) into a collection of ordinary PowerPoint objects.
Ungrouping and Changing Fill Color for Parts of an Image
When a vector-based drawing is ungrouped, it is converted into a collection of PowerPoint objects that can be deleted, resized, and repositioned, just like any drawn objects. Users can also change the fill color and border for parts of a picture that has been converted.

Deleting Parts of an Image
To delete pieces of an ungrouped image, users must select them and press [Delete].

Optimizing Photograph Images
When a presentation contains many photograph images, the file size increases tremendously. Optimizing these pictures can reduce the overall presentation’s file size. Optimizing is recommended if the presentation is to be viewed as a slide show or on the Web. 

A reduction in image quality is usually not noticeable on-screen, but it will make a difference in the printed version. To decrease the file size, users must use the Compress Pictures option from the Picture Toolbar.

Users also have the option to delete cropped areas of pictures to reduce its size.

	Additional Notes:

Unlike vector-based drawings, bitmap pictures cannot be ungrouped. To perform extensive editing on bitmap pictures, you need to use a paint-type program such as Imaging for Windows.


[image: image13.emf]Ungroup and Change  Fill Color for Parts of an Image


Additional Notes:

Not all clip art images can be ungrouped. 

Teaching Tip:
Tell students it is difficult to tell whether or not an image can be ungrouped by just its appearance. Simply try to ungroup to determine if it is possible.
Text Figure: F8-15
Text Figure: F8-16
Teaching Tip:
Inform students that some clip art pictures break into many pieces. Others break into groups of PowerPoint objects that must be ungrouped again to be able to modify the individual objects that make up the picture.
Text Figure: F8-17

[image: image14.emf]Delete Parts of an  Image


Teaching Tip:
Inform students that the Regroup command “remembers” the original dimensions of the picture even if part of the picture was deleted. If the picture is regrouped, it will not appear to be center-aligned after using the Align Center relative to slide command.

Text Figures: F8-18, F8-19
Additional Notes:

If the Picture Toolbar is not visible, choose the View Menu and Toolbars and select Picture.
Teaching Tip:
Inform students that optimizing photographs is a good option for reducing the presentation’s file size, but it may not be suitable for situations where printed slides are needed because the quality of the pictures will be reduced with compression.
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